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1. Migration of SAP Enterprise Portal 5.0 to
NetWeaver '04
Purpose
This document describes how to migrate the portal and Knowledge Management (KM) from
Enterprise Portal 5.0 SP6 to NetWeaver ’04 SP Stack 14.

The Migration Project
Migration from EP 5.0 to NW ’04 is an important undertaking and is to be approached as a
serious project, including extensive preparation and some downtime. Documentation and
SAP Notes should be read with appropriate attention.
Required Expertise Resources
To perform a successful and efficient migration expert knowledge in the following area is
required or must be available:
•

Application knowledge: specifically, the portal and KM

•

Database administrator

•

OS administrator

Registration
The migration procedure requires registration by means of a registration key. This is in order
to enable SAP to provide proper support for your migration project.For details, see
Registering the Portal Migration [Page 36].

Scope of the Migration Process
•

Migrate the system to NetWeaver ‘04

•

Optionally, change the operating system from Windows 2000 to UNIX

•

Migrate portal content, including Business Packages to the NW ‘04 system

Database and Disk Space Prerequisites
•

The temporary table space on the target system must be at least twice the size of the
PCD on the source system.
Most new relational database management system installations have an auto-expand
feature for the temporary table space. The flag for this feature must be on. For MS SQL
Server, this flag is on by default, but this should be verified.

•

Free disk space, or free space on the file system for Unix, on the target system, should
be at least the size of the PCD on the source system.

Limitations
•

It is not possible to migrate from one relational database management system to
another.

Although the migration process does not support migration across different
relational database management systems, for customers who want to switch
operating systems and/or databases, SAP provides a tool (the NW copy ) that is
capable of copying database content and adapting it as required, according to
operating system, database management system, or both.
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Using the NW copy tool to switch OS or DB, or both, must be done only after the
migration process is completed.
For detailed information on the NW Copy tool, see Homogeneous and
Heterogeneous System Copy for SAP Systems Based at SAP Web Application
Server Java 6.40 SR1, located at service.sap.com/instguidesNW ‘04 →
Installation, and SAP Note 785848. The guide and note include information
relevant for SR1 and later updates.
•

There is no support for the migration of Collaboration content between EP 5.0 and NW
’04.
If you work with collaboration rooms in EP 5.0, these must recreated on the target NW
’04 system. For detailed information on Collaboration see the Help Portal at
help.sap.com → Documentation → Language (English) → SAP NetWeaver → People
Integration → Collaboration.

List of Related SAP Notes
The SAP notes contain the most recent installation information, as well as corrections to the
installation documentation. Read the installation SAP note before beginning the installation.

Make sure that you have the most recent version of the SAP note. Find the
SAP Notes related to SAP Enterprise Portal in SAP Service Marketplace, at:
http://service.sap.com/NW ‘04doc → SAP Notes
For all SAP Notes, or for search by number, go to:
http://service.sap.com/notes

SAP Note Number

Title

732461

Central Note – Migration of EP & KM from 5.0 to NW '04

766765

Central Note – SAP EP 6.0 on Web AS 6.40 Release NW ‘04 SR1

832968

Central Note – SP Stack 14 – SAP NW ’04 on Web AS 6.40
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1.1. Overview - The Migration Process
Process
The migration process differs, depending on the components that are installed and the
migration path that you choose.
The migration process has six main phases:
nstallation on the target machine
...
Installation on the target machine

1. Installation on the target machine
In preparation for the migration, you install NetWeaver ‘04 SP Stack 14, or higher, on
the target machine.
The target machine must have the same components as the source machine. For
example, if the source machine has a portal and Knowledge Management installation,
you must install both these components on the target machine.
For more information about the installation procedure, see Installation of the Target
System - NetWeaver '04 [Page 17].
2. Pre-Migration Activities
There are pre-migration steps that must be performed prior to the migration process.
The portal and Knowledge Management each have their own specific set of premigration steps. There are also specific preparations if you are using portal content
from business packages. See the section, Preparations [Page 21] for the KM premigration information, Preparing for the Portal Migration [Page 36] for the portal, and
Preparing for Business Package Migration [Page 61] for the relevant information about
business packages.

If you are working with and migrating Knowledge Management, you must
perform all the pre-migration steps, for both the portal and KM, prior to the entire
migration process.
This is because for KM requires updated information from the portal in order to
migrate successfully.

Do the portal pre-migration steps before the preparations for the KM migration.
This is to maintain a proper workflow, since the portal must be live for the its premigration steps and the KM pre-migration requires you to shut down the portal.
3. Migration of Knowledge Management
If Knowledge Management is installed on the source system, then you must begin with
the migration of this component. If Knowledge Management is not installed, you can
begin with the migration of the portal.
For more information, see Knowledge Management Migration [Page 19].
4. Migration of the portal
For more information, see Enterprise Portal Migration [Page 33].
5. Migration of Business Packages
For more information, see Migration of Business Packages [Page 60].
6. Post Migration Activities
After completion of the migration processes for both KM and the portal, perform all
required post-migration procedures. For detailed information, see Post-Migration
Activities [Page 50].
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Migrating from a Clustered Configuration
...

1. If you want to migrate a to a clustered configuration for NW ‘04, first migrate to the
central instance of the target system, making sure that the J2EE Engine is shut on all
the other instances in the cluster.
2. After completing the migration, restart the J2EE on all other instances. The migrated
content is replicated automatically from the central instance.
For detailed information about J2EE Engine clustering, see help.sap.com → Documentation
→ SAP NetWeaver → Release ‘04 → <Language> → SAP NetWeaver → Application
Platform (SAP Web Application Server) → Java Technology in SAP Web Application Server
→ Administration Manual → Server Administration → Architecture Manual → Java Cluster
Architecture.
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1.2. Checklist for EP 5.0 to NW '04 Migration
Use
Migrating SAP Enterprise Portal involves a complex collection of activities, including
preparatory and post-migration activities. The migration activities performed may not be
identical for all, depending on the EP installation and configuration, for example, if KM is not
installed with the portal. Although the sequence of the checklist is generally in the order of
performance, some tasks may be done at the same time (recommended).
The checklist shows all the activities needed to perform the migration to NW ’04. The
Conditions column tells you whether or not the specific activity is relevant for you.Use the
checklist to make sure that all required actions are performed in the correct order.

Procedure
It is recommended to print the checklist and follow perform the activities, checking them off as
they are completed.

For the sake of clarity, the activities in this guide are largely organized and
divided according to KM and portal activities. This does necessarily mirror the
correct sequence in which to perform these activities. The checklist arranges the
activities sequentially and they should be performed the order they are listed,
skipping those that are not relevant to your system.
Note that the checklist indicates what activities can be performed simultaneously
with others in order to save time in the Workflow Notes.
Migration Checklist

;

Migration Activity

Condition

Install NetWeaver ’04 SR1 and upgrade to SP Stack 14
(or higher). See Installation of the Target System NetWeaver '04 [Page 17]
Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution
and/or hardware mirroring to back up the system, and to
back up the database.
Perform user management configuration as described
in SAP Note 777640.

For portal, only if the user
management engine on the
target system is to use an
LDAP directory as the data
source for user information

Navigate, explore and get to know the NetWeaver ’04
environment.
Verify the prerequisites to migration as described in:
Migration of SAP Enterprise Portal 5.0 to NetWeaver '04
[Page 7]

Prerequisites for KM, on
condition it is installed

Knowledge Management Migration [Page 19]
Enterprise Portal Migration [Page 33].
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Read the central note for this migration path, SAP Note
732461.
It is also recommended to review, before starting the
migration, the troubleshooting document attached to
SAP Note 703034. This document is updated from time
to time, and it may contain valuable tips and
workarounds.
Portal pre-migration
Prepare business packages for migration. See
Migration of Business Packages [Page 61].
Workflow Notes: Not dependant on sequence; can be
done at any time before migration at the same time as
other non-dependant tasks.

Portal content from business
packages exists on the source
system.

Obtain a registration key and register the migration
process. See Registering the Portal Migration [Page
36].
Workflow Notes: Obtain key is not dependant on
sequence; can be done at any time before migration at
the same time as other non-dependant tasks.
Entering registration key should be done simultaneously
with defining the default master language property for
migrated objects (if necessary), since both are entered
in the upgrader service.
Define the default master language property for
migrated objects. See Defining the Default Master
Language Property for Migrated Portal Objects [Page
37].

If this property requires
changing to other than English

Workflow Notes: Should be done simultaneously with
entering registration key.
Download and deploy the filtering and mapping file to
the target system to filter the EP 5.0 content to be
migrated. See Import Filter for Content Objects [Page
36].
Workflow Notes: Not dependant on sequence; can be
done at any time before migration at the same time as
other non-dependant tasks.

Portal content from business
packages exists on the source
system and/or there is other
EP 5.0 content that is not
compatible with the NW ’04
environment.

If mapping layouts is necessary, it should be done at
the same time as other filtering and mapping entries.
Map EP 5.0 Page Layouts To New Ones. See Mapping
Page Layouts [Page 39].
Workflow Notes: If mapping layouts is necessary, it
should be done at the same time as other filtering and
mapping entries.

Only if there are customized
page created other than the
portal default layouts

Prepare user management configuration for migration.
See Pre-Migration User Management Steps [Page 39].
Verify that the EP 5.0 system landscape is uploaded.
See Verifying Upload of EP 5.0 System Landscape
[Page 41].
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Remove and verify certain NW ’04 portal permissions.
For details, see Defining and Verifying Permissions
[Page 41].
Create a system in the NW ’04 portal that points to the
source system. See Defining and Configuring a System
for EP 5.0 [Page 42].
Check the contents of the supported languages table in
the EP 5.0 database. See Checking the EP 5.0
Language Table [Page 44].
Workflow Notes: Not dependant on sequence; can be
done at any time before migration at the same time as
other non-dependant tasks.
Copy EP 5.0 files to your NW ‘04 machine. See
Copying EP 5.0 Files [Page 44].
Workflow Notes: Compression of the files to copied
can be done at the same time as the KM migration is
being performed.
Shut down the source system.
Back up the file system and database of the NW ’04
target system. (This may be useful In the event that the
migration needs to be run again.)
Optional but strongly recommended: Run the
pre-migration Support Platform plug-ins. See Running
the EP 5.0 Support Platform Plug-Ins [Page 46]
Workflow Notes: Not dependant on sequence; can be
done at any time before migration at the same time as
other non-dependant tasks.
Restart the NW ’04 portal before migration.
Workflow Notes: Some of the portal pre-migration
tasks require restart of the portal to take effect. To save
time, restart can be done once after performing several
tasks.
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KM pre-migration
Verify the correct source system as described in
Checking the Source Version [Page 21].

Installation includes KM

Find out the database name for later use. See
Determining the Database Name [Page 22].

‘’

Find out the system IDs as described in Determining
System IDs [Page 22].

‘’

Download the KM migration tool. See Obtaining the
Migration Software [Page 23].

‘’

Shut down the portal as described in Shutting Down the
Portal [Page 23].

‘’

Back up the etc directory. See Backing Up the etc
Directory on the Target System [Page 23].

‘’

Copy the file system data of local fsdb repositories from
the source to the target system. See Copying Data for
Local fsdb Repositories [Page 24].

‘’

Run the Migration Exporter tool on the source system to
store configuration data and other system data in an
archive file. See Collecting Information on the Source
System [Page 24].

‘’

KM migration
Copy the archive file MigrationInput.zip from the
source to the target system and then start the KMC
Migration Tool. See Using the Migration Tool [Page 25].

Installation includes KM

Run reports to identify additional migration steps you
must perform. See Running Reports [Page 26].

‘’

Merge etc directory contents from source and target
systems. See Merging the Contents of the etc Directory
[Page 28].

‘’

Migrate the source database. If fsdb repositories are
configured, synchronize the fsdb data that is located on
the file system with the metadata stored in the
database. See Migrating the Database [Page 28].

‘’

Merge the source and target configuration data. See
Migrating the Configuration [Page 31].

‘’

Log onto the target portal and import the compatibility
package. See Importing the Compatibility Package
[Page 31].

‘’

Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution
and/or hardware mirroring to back up the system, and to
back up the database.
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Portal migration
Run the portal migration as described in Migrating the
Portal [Page 48].
Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution
and/or hardware mirroring to back up the system, and to
back up the database.
Supplementary Tasks
On target system, perform Java system copy as
documented in Homogeneous and Heterogeneous
System Copy for SAP Systems Based at SAP Web
Application Server Java 6.40 SR1, located at
service.sap.com/instguidesNW ‘04 > → Installation.

Only if it your project includes
switching OS or DB, or both

See Limitations [Page 7].
Upgrade target system to the latest version (SP Stack
or higher).
Recreate Collaboration rooms. For information, see
help.sap.com → Documentation → Language (English)
→ SAP NetWeaver → People Integration →
Collaboration.

Only if your source system
used Collaboration

KM post-migration
Perform the manual migration steps that are specified in
the results of the Migration Tool reports. See
Performing Tasks Identified by Reports [Page 50].

Installation includes KM

Delete obsolete system IDs, as described in Deleting
System IDs [Page 51].

‘’

Manually initialize templates and object types. See
Initializing Ad Hoc Workflow Templates and Object
Types [Page 52].

‘’

Re-assign user to roles. See Assigning Users to New
NW '04 Roles [Page 52].

‘’
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Portal post-migration
Perform the post-migration steps for User Management
[Page 53].
Check permissions as described in Removing and
Verifying Permissions [Page 54].
Manually migrate EP 5.0 styles. See Styles and
Themes [Page 54].
Check what post-migration activities you need to
perform for the J2EE Engine and regarding developed
content. See J2EE Engine and Content with Code
[Page 55].

Existence of customized J2EE
Engine configurations and/or
customer- developed
components

Reset proxy server settings. See Reconfiguring the
Proxy Server [Page 55].

Source portal works with proxy
server

Recreate trust to back-end systems. See Working with
Back-End Systems [Page 55].

Existence of systems based
on back-end applications

Define default alias for using EP 5.0 .NET iViews. See
Support EP 5.0 .NET iViews [Page 55].

.NET iView migrated

Make options menu available for all external services.
See External Services Based on Standard.PAR [Page
56].

Existence in source of external
services based on
Standard.par

Enable access to EP 5.0 portal favorites as described in
Migration of EP 5.0 Favorites [Page 56]

Portal content objects defined
as browser Favorites

Save migration default traces for troubleshooting
purposes. See “console log files” in Checking the Status
of the Portal Migration [Page 59].
Business Package post-migration
Perform the post-migration steps that may be
necessary, as indicated in Post-Processing Steps for
the Migration [Page 63].
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1.3. Installation of the Target System - NetWeaver '04
Prepare the target system for your migration, by installing NW '04 - SAP Enterprise Portal on
Web AS 6.40.

The NW ’04 environment is very different from what the users and
administrators of EP 5.0 have been used to working with. It is therefore very
important to navigate, explore and gain familiarity with as many aspect of the
NW ’04 environment as possible before migrating content.

1.3.1. Planning the Target System
While migrating, you can upgrade the operating system and you can switch from Windows to
UNIX.
You cannot change the relational database management system (RDBMS).
Supported Source and Target Systems
EP 5.0 SP6

NetWeaver '04

Win 2000/ MS SQL 2000

Win 2000/ MS SQL 2000

Win 2000/ MS SQL 2000

Win 2003/ MS SQL 2000

Win 2000/ Oracle 8.1.7

Win 2000/ Oracle 9.2

Win 2000/ Oracle 8.1.7

Win 2003/ Oracle 9.2

Win 2000/ Oracle 8.1.7

HP-UX 11(i)/ Oracle 9.2

Win 2000/ Oracle 8.1.7

Solaris/Oracle 9.2

Win 2000/ Oracle 8.1.7

AIX 5.2/ Oracle 9.2

Win 2000/ Oracle 8.1.7

United Linux/ Oracle 9.2

Win 2000/ Oracle 8.1.7

Red Hat Linux/ Oracle 9.2

Switching RDBMS is possible after the migration by using the NW copy tool.
Since the copy tool also enables switching OS, you may decide to perform the
migration to the same target OS as the source and then make the desired OS
and DB changes later. See the reference to the copy tool documentation in the
beginning of this guide, Migration of SAP Enterprise Portal 5.0 to NetWeaver '04
[Page 7], under Limitations.
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1.3.2. Installing SAP Enterprise Portal on the Target System
Obtaining a running SAP Enterprise Portal on Web AS 6.40 requires the following steps:
...

1. Install the NW '04 SR1
See the guide Installation Guide - SAP Enterprise Portal 6.0 on Web AS 6.40, located
at service.sap.com/instguidesNW ‘04 → Installations.
2. Upgrade the installation by installing SAP NetWeaver 2004 SP Stack 14 (or higher).
The installation of SP Stack 14 is decribed in Support Package Stack Guide – SP stack
14, located at service.sap.com/instguidesNW ‘04 → Operation → Cross-NW.
3. Install Knowledge Management and Collaboration NW ’04. For more information, see
the section Installation of Knowledge Management and Collaboration in the installation
guide referred to in step 1.

You install exactly the same components on both the source and target system.
If only the portal is installed on the source system, then install only the portal
now and, if desired, add Knowledge Management and Collaboration later, after
you have successfully completed the migration.

Recommendations
Source System
It is strongly recommended to maintain your EP 5.0 SP6 portal before migration to NW ’04. It
will ensure easy troubleshooting in case of problems.
In order to support migrated content that points to a URL in the EP 5.0 system, you must keep
the EP 5.0 system up and running.
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2. Knowledge Management Migration
Purpose
The migration transfers the content of Knowledge Management from an EP5.0 SP6 system to
a NW ‘04 system. It also enables a change in operating system from Windows 2000 to
Windows 2003 or UNIX.

Prerequisites
SAP Enterprise Portal and Knowledge Management are installed on the target machine and
have the version SAP NetWeaver ‘04 SP Stack 14 (or higher).

Process Flow

Before you begin the migration, read SAP Note 732461. It contains the latest
information on the migration, including corrections to this guide.
When you migrate Knowledge Management, you need to:
•

Migrate Content Management

•

Migrate TREX Retrieval and Classification to TREX 6.1.14.

You migrate Content Management before you migrate the portal.

Migration of Content Management
The migration of Content Management involves a number of steps. The list below gives you
an overview of the steps and shows the order in which they must be performed. If Content
Management is installed on a cluster configuration, then the migration procedure is the same
as for a standard configuration. However, after the migration, it is necessary to check the
assignment of scheduled tasks to systems.
For detailed instructions on individual steps in the following list, see the corresponding
sections later in the guide.
...

1. Preparations [Page 21]
a. Make sure the source system has the version EP5.0 SP6 patch 1 with at least
hotfix 10 for KM.
b. Make a note of the name of the KM database on the source system.
c. Make a note of the system ID on the source system.
Cluster only:
In a cluster configuration, there are several system IDs.
d. Download the software for the migration from the SAP Software Distribution
Center.
e. On the source and target system, shut down the portal. Leave it shut down on
both systems for the entire migration. The databases of both source and target
systems must be up and running.
f. On the target system, back-up the etc directory.
g. Copy the file system data of local fsdb repositories from the source system to
the target system.
h. On the source system, run the Migration Exporter tool to collect input data for
the migration and to store it in the archive file MigrationInput.zip
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2. The Migration [Page 25]
a. On the target system, extract the KMC Migration Tool to a temporary folder.
b. Copy the file MigrationInput.zip containing input data for the migration
from the source system to the folder with the KMC Migration Tool on the target
system.
c. Use the KMC Migration Tool to:
i.

Run reports that identify additional actions that are required for the
migration.

ii.

Merge the contents of the EP5.0 and NW ‘04 etc directories.

iii.

Migrate the database content and synchronize data for fsdb repositories.

iv.

Merge the EP5.0 and NW ‘04 configuration data.
If required, exclude the XML configuration files of customer
developments from the migration. For more information, see Migrating
the Configuration [Page 31].

d. Prepare for the migration of EP5.0 iViews to NW ’04 with the import of the
Compatibility package into the target system. The package enables the use of
EP5.0 iViews in NW ‘04.

Perform this step only if you want to use existing EP5.0 iViews in NW ‘04. The
iViews are migrated later during the portal migration.
3. Post-Migration Activities [Page 50]
A number of actions are necessary to complete the Knowledge Management Migration.

You perform these steps after you have finished the portal migration.
a. Analyze the Customer Component and Repository Managers reports that are
generated by the KMC Migration Tool at the beginning of the migration. Perform
the manual migration tasks that are necessary to complete the migration.
b. Delete obsolete system IDs on the target system:



In a system with a single instance, delete the obsolete NW ’04 system ID.



In a cluster, delete old system IDs and then ensure that scheduled tasks
are assigned to new NW ‘04 system IDs.

c. Initialize templates and object types for Ad Hoc Workflow.
d. Assign users to new NW ‘04 Roles.
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Migration of TREX to EP6.1.14
You can migrate TREX before or after the Content Management and Collaboration migration.
For the migration, you install the new TREX 6.1 SR1 version on the same machine as the old
TREX installation. You then migrate the indexes from the old system to the new system.
For more information about the migration procedure, see SAP Service Marketplace at
service.sap.com/instguidesNW ‘04 → Upgrade → Cross-NW → Component
Migration Guide - Search and Classification (TREX)

When you follow the instructions in the migration guide, make sure that you
establish the connection between TREX and the Knowledge Management
application (the client). To do this, you need to configure the TREX Service in
the SAP J2EE Engine Visual Administrator Tool.
After migrating the TREX indexes, apply Support Package Stack 14 ( for TREX). After this
upgrade, the target version is TREX 6.1.14.
For information about the SP Stack upgrade, see
service.sap.com/instguidesNW ‘04 → Operations → Cross-NW →
Support package Stack Guide - SAP NetWeaver 04 SP Stack 14.

Results
The Content Management migration moves the EP 5.0 database content and configuration to
the NW ‘04 system and updates them. The EP 5.0 configuration data is transferred from the
file system into the NW ‘04 database.
Note that the repositories configured in the EP 5.0 system will not be accessible on the target
system. To make them accessible, you need to perform the additional actions that are
specified in the results of the Repository Managers report [Page 26] which checks the
repositories.

2.1. Preparations
Purpose
Before you begin the migration, you need to perform a number of preparatory steps.

2.1.1. Checking the Source Version
Use
The source system for the migration must have the version CM 5.0 SP6 patch 1 hotfix 10 for
KM. Before you start the migration, ensure that you have the correct source version.

Procedure
...

1. Open the registry. To do this, choose Start → Run and then enter regedit in the
Open field.
2. In the registry, choose My Computer → HKEY_LOCAL_MACHINE → SOFTWARE →
SapPortals → CM
3. Look for an entry like the following with at least hotfix 10 (for KM):
CM SP6 Patch1 hotfix <number>
If a lower patch version or hotfix than required is displayed, then you do not have the
correct source version for the migration. In this case, you must install the missing
patches before proceeding with the migration.
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2.1.2. Determining the Database Name
Use
Before the migration make sure that you know the name of the CM database. You need to
specify the name when you migrate the database with the migration tool.

Procedure

If you are certain that the system uses the default database name wcm, you can
skip this procedure:
...

1. In the portal, access the connection pools with KM-Admin → Configuration →
Content Management → Utilities → JDBC Connection Pools.
2. In the definition of the connection pools, identify the Database Name and make a note
of it for later use. If the variable %DBSID% appears instead of a database name, then
you need to make a note of the name specified for DBSID in the
config_local.properties file.

2.1.3. Determining System IDs
Use
You need to find out the system ID on the source system and make a note of it. Later, when
you have completed the migration, you need to delete the ID on the target system because it
is obsolete. The NW ’04 target system uses new IDs.

Cluster only:
There are several system IDs in a cluster.

Procedure
...

1. On the source system, log on to the portal and choose KM Admin → Configuration →
Content Management →Global Services → System Landscape Definitions →
Systems → Content Management Systems.
2. For later use, make a note of all the system IDs that are displayed.
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2.1.4. Obtaining the Migration Software
Use
You download the software for the migration from the SAP Service Marketplace.

Procedure
...

1. Access the migration software at service.sap.com/swdc → Download → SAP
Support Packages → Entry by Application Group → SAP NetWeaver → SAP
NETWEAVER → SAP NETWEAVER 04 → Entry by Component → EP Migration.
Choose the relevant migration path and then #OS Independent..
2. Download the file KMCMIGTOOL_<number>.sar
Where <number> represents the version of the tool.
Extract the contents on a local machine using the SAPCAR tool:
sapcar –xvf KMCMIGTOOL_<number>.sar
3. Copy the following file to a temporary directory on the source system:
MigrationInfoExporter.zip
Copy the following file to a temporary directory on the target system
MigrationTool.zip

2.1.5. Shutting Down the Portal
•

On the source system, make sure that all users have saved and checked in their
documents and are logged off.

•

On the source and target system, shut down the portal. Leave it shut down on both
systems until the end of the migration. The databases of both the source and target
systems must be up and running.

•

Cluster only:
Make sure the portal is shut down on all the nodes in the cluster.

2.1.6. Backing Up the etc Directory on the Target System
Use
On the newly installed NW ‘04 target system, back up the etc directory containing system
data. You need this backup if the migration of the etc directory fails. The backup enables you
to restore the original state so that you can repeat the migration.

Procedure

Cluster only:
Perform this step on the central instance.
...

On the target system, back up the etc folder.
Windows:
\usr\sap\<system_name>\SYS\global\config\cm\etc
UNIX:
/usr/sap/<system_name>/SYS/global/config/cm/etc
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Copying Data for Local fsdb Repositories

Use
fsdb repositories store resources on the file system and metadata for these resources on the
database. The data in the database is automatically transferred to the target system during
the database migration. However, the data on the file system is not transferred automatically.
If it is stored in a local directory, you need to copy it manually to the target system.

If the file system data for an fsdb repository is stored on a remote share, no
special copy operation is necessary.

Copying File System Data to the Target System
For each local fsdb repository that you want to use on the target system:
1. Create a directory on the target system.
2. Compress the data on the source system and then copy it to the newly created
directory on the target system.
3. Unpack the data on the target system.
4. For later reference, note down the name of each fsdb repository and its root directory
on the target system.
You need the information later during the last phase of the database migration. In this
phase, you adapt the configuration settings of the fsdb repositories so that they are
valid for the target system.

2.1.7. Collecting Information on the Source System
Use
You run the Migration Exporter tool to:
•

Export the configuration data

• Collect data on the source system which is required as input for the migration
The Migration Exporter tool saves both the configuration and input data in an archive file
MigrationInput.zip. The data in the file is required later, on the target system, as input
for the KMC Migration Tool.

Procedure

Cluster only:
Perform this step on the central instance.
...

1. On the source system, extract the file MigrationInfoExporter.zip tool to a
temporary folder. You downloaded this file from the SAP Software Distribution Center
in preparation for the migration.
2. Run the tool from the temporary folder. To do this, enter the command:
MigrationInfoExporter.cmd

The Migration Exporter tool exports both the configuration data and further system data
to the file MigrationInput.zip.
3. Remember the location of the MigrationInput.zip file. Later, you copy the file to
the temporary folder on the target system where the KMC Migration Tool is located.
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2.2. The KM Migration
Purpose
You perform the main steps of the migration with the KMC Migration Tool. You use the tool to
run reports that return information about the system, to merge the contents of the EP 5.0 and
NW ‘04 etc directories, and to migrate both the database and configuration.

2.2.1. Using the Migration Tool
Use
You perform all the central migration tasks with the KMC Migration Tool. You run the tool on
the target system.

Procedure
Starting the Tool

Cluster only:
You run the migration tool on the central instance of a J2EE cluster.
On the target system proceed as follows:
...

1. To ensure that you have the authorizations required for the migration, we recommend
that you log on as SAP J2EE Engine administrator.
2. Extract the file migrationTool.zip to a temporary directory. You downloaded this
file from the SAP Software Distribution Center in preparation for the migration.
You can use any extraction tool, for example, WinZip.
3. Copy the file MigrationInput.zip, which contains the input data for the migration,
from the source system to the temporary directory you created in the previous step.
4. Start the KMC Migration Tool.
a. UNIX only: Before you can run the tool, you need to set the execute permission
with the command:
chmod 777 <file_name>
b. To run the tool, switch to the temporary directory and start the script appropriate
for your operating system.
For Windows start:
go.cmd
For UNIX start an X-Session and enter:
./go.sh
The tool opens and offers you all the options that you need to carry out the migration:
Reports, ETC, DB and Config.
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Working with the Tool
...

1. To enable the tool to access all the information it needs during the migration, you must
specify the SAP System Name (SAPSID).

FP8
2. Work through the options in the sequence shown on the initial screen, from left to right.
Before you start a new migration step, always check whether the previous step has
completed. If you start a step before the previous one has completed, the data on the
target system will be inconsistent.
For details about each step, see the sections below.
Log File
The tool writes information to the log file KMCMigrationTool.log which is located in the
directory where you start the migration tool.

2.2.2. Running Reports
Use
The KMC Migration tool includes reports that you run to identify additional steps that you need
to perform to complete the migration. The reports generate information that is required for
different purposes at different stages of the migration.

The target KMC system may not start up if you do not perform the steps
specified in the results of the reports after the completion of the portal migration.

Repository Managers Report
This report identifies tasks that are necessary to configure repositories on the targets system
correctly. You need the results of the report later, after the migration of the Portal Platform, to
manually configure the repositories.
For more information, see Performing Tasks Identified by Reports [Page 50]
The report finds out, for example, whether:
•

Local paths and remote paths are accessible and the parameter LocalRoot has a
valid value

•

The LocalRoot Versioning has a valid value for CM repositories

•

W2K Security Manager is in use. On UNIX the report issues a warning.

If you do not want to use the repositories that are configured on the source
system on the target system, you do not need to run the report.
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Customer Components Report
The report identifies components that were developed and integrated in the application after
the original KMC installation. These customer components are not automatically transferred
to the target system during the migration. To deal with them, you have two options. You can:
•

Manually deploy the java classes of the components on the target system. You do this
after the migration of the Portal Platform. For more information, see Performing Tasks
Identified by Reports [Page 50].

•

Decide that you do not need the components on the target system. In this case, you
have to exclude the xml configuration files of the components from the migration to the
target system. You can do this when you run the Config option of the KMC Migration
Tool. For more information, see Performing Tasks Identified by Reports [Page 50].

If after the test migration you cannot access KMC, we recommend that you
remove the xml configuration files of the customer components before repeating
the test migration.
If the source system has customer components and you do not exclude the corresponding
XML configuration files from the migration, then the target system will display errors related to
these components. You can temporarily ignore these errors until after the portal migration
when you need to deal with the migration of the customer components. Only ignore the errors
that are related to the components which are identified by the customer component report. If
you notice other errors, you need to resolve them.

Database Deployment Report
The report determines whether the CM repositories on the source system store data in more
than one database. This check is necessary because only one database instance is permitted
on the target system. There all data for CM repositories is stored in the Java schema of a
single SAP J2EE Engine database instance.

If the tool finds out that more than one database is in use, you need to contact
SAP support to get special assistance for the migration.

Procedure
To run a report, proceed as follows:
...

1. On the initial screen of the KMC Migration Tool, choose Reports.
The Report Tool window opens.
2. Specify a folder to store the results of the reports in the field Save reports results into.
3. Select the report you need to execute and choose Run.
The report starts and writes status information on the screen. Errors are indicated in
red.
4. Analyze the results of the report. You open the results in the folder you specified earlier
or with File → View latest Report.
5. If the Customer Components or Repository Managers report contains information that
makes further migration steps necessary, perform these when you have run all the
options offered by the KMC Migration Tool and migrated the portal.
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2.2.3. Merging the Contents of the etc Directory
Use
In this procedure, the contents of the old (EP5.0) and new (NW ‘04) etc folders are merged
and copied to the target system.

Procedure
...

1. On the initial screen of the KMC Migration Tool, choose ETC.
The ETC Migration window opens. It shows the Source Folders (EP5.0), the Target
Folders (NW ‘04) and a Temporary Folder. The Temporary Folder is a working folder
that shows the merge process.
2. Choose Start.
The merge process begins. You can follow the progress in the displayed folders and
the output displayed at the bottom of the window. The time that has elapsed for the
merge is also shown in milliseconds. When the process has finished the following
message appears:
Etc directory migrated successfully in <milliseconds>

If you need to repeat the merge, you can restore the original etc directory on
the NW ‘04 target system using the backup you made in preparation for the
migration. For more information, see Backing up the etc Directory on the Target
System [Page 23].

2.2.4. Migrating the Database
Use
You run the Database Migration tool to automatically migrate the EP5.0 source database to
the NW ‘04 target database. In addition, if the migration process includes fsdb repositories,
you use the tool to synchronize these repositories on the target system.

Prerequisites
On the source and target system make sure that the portal is shut down and the database is
running.

Procedure
To migrate the database:
...

1. On the initial screen of the KMC Migration Tool choose DB.
The DB Migration window opens.
2. Enter the required data as shown in the input table below and then choose Start.
When the migration begins, the bottom part of the screen shows the progress of the
conversion and reports any errors that occur. The time required for the migration
varies, depending on the processing power of the target machine. Normally the
process takes several hours.
3. If fsdb repositories exist on the source system, perform the fsdb synchronization. The
FSDB Synchronization screen, which you require for this task, appears after completion
of the database migration. For the synchronization you:
a. Adapt the configuration settings of the fsdb repositories so that they are valid for
the target system
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b. Perform the synchronization which ensures that data on the file system and
metadata on the database are synchronized.

Input for Database Migration Tool

If you are uncertain of the DB user and password, which you have to enter, you
can test it as follows:
Oracle
Open the Enterprise Manager Console with Start → Programs → Oracle →
Enterprise Manager Console. Choose the instance and enter username and
password for CM. If the logon fails, you might need to enter a new password.
MS SQL Server
Open the Query Analyzer with Start → Programs → Microsoft SQL Server →
Query Analyze and use SQL Server Authentication. Enter the user and
password for the CM database. If the login fails, you might need to change the
password.
For more information on setting a new password for Oracle or MS SQL Server,
see SAP note 687576.

Source
DB Server

Enter the IP Address of the machine where the source
database server is installed.
To find out the address enter the command:
netstat –n

DB Type

Enter SQL Server or Oracle.

DB Name

Enter the name of the database. This can be the default wcm
or the name you determined earlier in the connection pools or
the DBSID entry of the config_local.properties file. For
more information, see Determining the Database Name [Page
22]

DB port

For MS SQL Server: Enter the port number for the database.
The default is 1433.
For Oracle: Enter the Listener port for the database. The
default is 1521 or 1527.

DB User

Enter the user with which CM connects to the database.
The MS SQL Server default user is wcm
The Oracle default user is wcm.

DB Password

Enter the password for the CM database connection.
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Synchronizing the fsdb Repositories
You perform the synchronization at the end of the database migration, when the FSDB
Synchronization screen appears. The synchronization ensures that the fsdb data on the file
system corresponds to the metadata in the database.

To prevent the loss of fsdb metadata on the target system, you must perform the
synchronization at this point in the migration process.
Proceed as follows:
1. In preparation for the synchronization, configure the fsdb repositories correctly for the
target system. To do this:
a. Select a repository that is displayed on the FSDB Synchronization screen.
The color in which the root repository is displayed changes to green, red or
orange.
b. Find out the meaning of the color with the help of the table below and then
perform the actions that are recommended to correct the configuration.
2. Synchronize the data on the files system with the metadata on the database. To do
this:
a. Select all fsdb repositories for which you copied data from the source to the
target system.
b. Click Start to trigger the synchronization process.
The process takes few minutes to complete. When it has finished, you are
informed in the status area of the FSDB Synchronization screen.

Color

Meaning

Required Action

Red

The root directory that is specified for
fsdb data on the source system does
not exist on the target system.

Click on the path displayed in red and
navigate to the correct directory on the
target system. You created this directory
in preparation for the migration.

Orange

The root directory that is specified exists
on the target system, but does not
contain the data for the fsdb repository
which is selected on the screen.

Click on the path displayed in orange
and navigate to the directory on the
target system which contains the data
for the repository in question. You
created this directory in preparation for
the migration and then filled it with fsdb
data from the source system.

Green

The repository involved is configured
correctly on the target system

No action

Black

The repository involved is not selected.
Colors indicating the validity of the
configuration are not displayed.

No action
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2.2.5. Migrating the Configuration
Use
The migration of the configuration merges the EP5.0 and NW ‘04 configuration data and
transfers it from the file system to the database. It also offers a screen to exclude XML files
containing configuration data for custom developments from the migration. You exclude these
files if:
•
•

You no longer need the custom developments on the target system
The custom developments are incompatible with the SAP NetWeaver version on the
target system and are not yet available in the version required for the target system.
Earlier in the migration procedure, you used the Customer Components report to identify
components which were added to KMC after the original installation. The configuration files
for the components are transferred to the target system during the migration of the
configuration, however, without the corresponding java classes. These have to be transferred
manually after the portal migration. If you do not need the customer components on the target
system, or if you do not yet have a version of them which is compatible with the target
system, you can exclude the corresponding configuration files from the migration, using the
Config option of the migration tool.

Procedure
...

Close any explorers or applications that are open and can access directories with
configuration data.
1. On the initial screen of the KMC Migration Tool, choose Config.
The Custom Code Development Removal screen opens.
2. Proceed as follows:
•

•

If you want to start the migration of the configuration and include XML configuration
files for custom developments:
i.

Choose Quit.
The KMC Configuration Migration screen opens.

ii.

Choose Run to start the migration of the configuration.

If you want to exclude XML configuration files of custom developments from the
migration:
iii.

Select the XML files you want to exclude and then choose Start.
The XML files are removed from the list of migration files and then the
KMC Configuration Migration screen opens.

iv.

Choose Run to start the migration procedure.

The migration of the configuration begins and displays the status at the bottom of the
window. Errors are displayed in red.
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2.2.6. Importing the Compatibility Package
Prerequisites
The compatibility package is provided in the KmCompatibilityPackage.zip file that is
attached to SAP note 640634. Fetch the file in preparation for the import.

Procedure
Copy the ...

1. On the target system, extract the file KmCompatibilityPackage.zip to the
following directory on the portal machine:
\usr\sap\<system_name>\sys\global\pcd\Import
Make sure that access to the import folder is not restricted with read-only,
otherwise the import will fail. For more information, see note 681323.
2. Log on to the portal as super administrator and choose System Administration →
Transport → Import.
3. For Source for Package Files, select Server. Choose Browse and navigate to the file
package.pkg which contains the compatibility package. Select the file so that it is
displayed on the import page.
4. Make sure that the option Content to be overwritten is set to All.
5. Choose Import to import the compatibility package. The import takes a while. To find
out whether the import has completed, choose View Log.
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3. Enterprise Portal Migration
The portal of NetWeaver ‘04 is a more advanced and versatile portal version than EP 5.0, as
well as being platform independent. The migration utility, included with the NW ‘04 installation,
adapts EP 5.0 content so that it can be integrated by the new portal version. This offers the
users of the organization the technical benefits of NW ‘04 without the loss of data or user
management configurations.
The migration is an automated process, but requires some manual, preliminary steps as well
as important post-migration procedures.

If your system includes KM, the migration for KM must be performed before the
portal migration. For migrating Knowledge Management (KM), there are different
tools and processes than for the portal. For more information, see Knowledge
Management Migration [Page 19].
For additional useful information, see Scope of Portal Migration - EP 5.0 to NW '04 [Page 34]
before starting the migration process.
For the latest information and updates about the migration process from EP 5.0 to NetWeaver
‘04, consult SAP Note 732461.

Prerequisites
•

You are running EP 5.0 SP6 with Patch 1.
If you are running an earlier EP 5.0 version, then upgrade your portal to SP6 and apply
Patch 1. For information on upgrading, to SP6, go to service.sap.com/epinstall → SAP
NetWeaver → SAP NetWeaver in Detail → People Integration → Portal → Media
Library → Documentation & More → EP 5.0 → Installation, Upgrades &Patches.

•

NetWeaver ‘04 SP Stack 14 portal is installed on the target machine (to which the EP
5.0 content is to be migrated).
See EP Installation Sequence: Including KM & Collaboration [Page 17].

It is recommended to create and save an image of your NW ’04 installation.
•

Java Virtual Machine (JVM) settings are configured as recommended in SAP Note
696410.

Process Flow
Although most of the migration of the content on your NW ‘04 machine is automatic, some
manual steps are involved in preparation for migration and after migration has completed.
To prepare for automatic migration you must do the following:
•

Prepare business packages for migration.
Follow the steps necessary for preparing business packages for migration, particularly
making sure versions are synchronized with the version of your NW ‘04 portal
installation.
For detailed information about the migration business packages, see Migration of
Business Packages [Page 60] in this guide.

•

Obtain a registration key to enable the migration (see SAP Note 854791) and register
the migration. See Registering the Portal Migration [Page 36]

•

Perform all tasks necessary for migrating the portal as described in Preparing the
Portal for Migration [Page 36].
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•

Shut down the source system.

•

Run the migration utility. See Migrating the Portal [Page 48].

3.1. Scope of Portal Migration - EP 5.0 to NW '04
The migration of EP 5.0 to NW '04 includes the following components:
•

Portal archives (PAR & ZAR files)

•

Content objects
The migration of content objects includes .NET and Java iViews, delta links, pages,
roles, worksets, channels (converted to folders, the IDs of which are created from the
channel name), and external services.

•

User management

•

User mapping

•

Role assignments

•

Channel-to-role assignments

•

Systems

•

Data sources
The migration of data sources translates them in a system of type “data source,” having
its own system template.

•

Personalizations

The migration of EP 5.0 to NW ‘04 does not include the following components:
•

The migration of themes and styles is not performed automatically. For details, see
Process Flow in Enterprise Portal Migration [Page 33] and Post-Migration Procedures
[Page 53].

•

Unifier projects

•

iPanel

•

.NET iViews that do not have matching portal components in NW ‘04 are not migrated.
Currently, only URL, Yahoo, and ASP iViews are supported.

ASP iViews are supported with the following limitations:
•

The IIS on which they are located must be up and running.

•

If an ASP points to a URL in the EP 5.0 portal, the EP 5.0 portal needs to
be up and running to view results.
In addition, a trust relationship must be created between the target
NW ’04 and the EP 5.0 portals, so that the EP 5.0 portal will trust the
logon ticket of the NW ‘04 system. For information on creating trust, see
SAP Note 711769.
(To create an iView in the NW ’04 portal that has EP 5.0 ASP content,
you need to create a URL iView that points to the URL on the EP 5.0
server.)

•

If an ASP returns content that is dependent upon and specific to the EP
5.0 system (such as unsupported EP 5.0 tags), that content is not
supported by the migration process. See SAP Note 774592.
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•

The NW ’04 portal supports the URL tags <DBHOST HOST>, <DBHOST
PROTOCOL>, <DBHOST PORT>, <DBHOST HOST PORT>, and <DBUSER
USERID>. ASP iViews requiring additional tags are not supported.

•

iViews that contain supplementary files

•

Customer-defined layouts, defined as follows:
{

Layouts manipulated by changing default ASP files

{

New customer-created layouts

Such layouts must be recustomized in NW ’04 after the migration. For information, go
to the portal administration guide on the help portal, System Administration → Portal
Display.
About characters in the object ID:
An object ID (technical name) in NW ‘04 can contain only the following characters: "0" to "9",
"A" to "Z", "a" to "z", forward slash ("/"), period (".”) underscore (“_”), percent sign ("%”), tilde
(“~”), hyphen (“-“), and opening and closing parentheses “()".
During migration, different characters are replaced by their escape version. For example, "My
Channel" in NW ‘04, will appear as "My%20Channel".
Neither functionality nor object title are affected.
Flow at the Back End:
The automated back-end flow of the migration is as follows:
•

Data from EP 5.0 is exported from:
{

Portal repository database

{

Portal Content Directory (PCD)

{

Portal LDAP directory

•

The exported data is processed and adapted to the NW ‘04 system.

•

The processed data is imported into the NW ‘04 portal system database

Migrating to a Clean NW ‘04 Installation
Although it is not a requirement, it is recommended to perform the migration procedure
described in this guide to a machine housing a clean portal installation, i.e. containing no new
content added prior to the migration of content from your EP 5.0 machine.
The reason for this recommendation is a follows:
Suppose you have finished installing NW ‘04, as required, and then you have imported
content from a business package from iView Studio. You make administrative changes and
personalize iViews and pages.
If you have the same objects on your EP 5.0 machine, during migration this content is
transferred to the same directory as the imported content, and any administrative changes
and personalization made on the NW ‘04 installation are overwritten.
You can partially work around this problem by exporting your new modified content, and then
re importing it after the migration. However, this workaround, although it saves administrative
changes, loses personalization during the export.
(To import and export content in NW ‘04, navigate as follows: System Administration →
Transport → Export/Import.)
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3.2. Preparing for the Portal Migration
Before migrating the old system to the new one, several preparation steps are required.
Follow the instructions described in the sections below. The following topics are included:
•

Migration of Business Packages [Page 60]

•

Registering the Portal Migration [Page 36]

•

Defining Default Master Language Property for Migrated Objects [Page 37]

•

Import Filter for Content Objects [Page 38]

•

Mapping Page Layouts [Page 39]

•

Pre-Migration User Management Steps [Page 40]

•

Verifying Upload of EP 5.0 System Landscape [Page 41]

•

Defining and Verifying Permissions [Page 41]

•

Defining and Configuring a System for EP 5.0 [Page 42]

•

Checking the EP 5.0 Language Table [Page 44]

•

Copying EP 5.0 Files [Page 44]

•

Running the EP 5.0 Support Platform Plug-Ins [Page 46]

3.2.1. Registering the Portal Migration
Use
The registration process includes obtaining a key from SAP, for information about your
migration project is required. This helps SAP provide optimal support for your project. To
obtain a registration key, follow the instructions provided in SAP Note 854791.
The registration procedure described here may be performed at any time prior to running the
migration utility.

Procedure
...

1. Go to System Administration → System Configuration → Service Configuration and
browse to Applications → com.sap.portal.upgrader.upgraderservice →
services → UpgraderService.
2. Open the UpgraderService Property Editor, by right-clicking UpgraderService and
choosing Configure, or by double-clicking UpgraderService.
3. In the Registration Key field, enter the registration key received by following the
instructions in SAP Note 854791, and choose Save.
4. Restart the portal.

Changes to portal services require restart. If you are planning to make other
changes requiring restart, for example Defining Default Master Language
Property For Migrated Objects [Page 37], then avoid multiple restarts. Just make
sure to restart the portal before migration.
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3.2.2. Defining Default Master Language Property for
Migrated Objects
Use
The default master language of iViews and Pages migrated from EP 5.0 is English (en). The
default master language can be changed by performing the following pre-migration
procedure:

Procedure
...

1. Go to System Administration → System Configuration → Service Configuration and
browse to Applications → com.sap.portal.upgrader.upgraderservice →
services → UpgraderService.
2. Open the UpgraderService Property Editor, by right-clicking UpgraderService and
choosing Configure, or by double-clicking UpgraderService.
3. Change the upgrader.MasterLanguage property to the desired language using the
locale convention (only the language property part without the country, for example fr,
de).

In the field The display format of the migration log, the value “HTML” appears. If
desired, you may change the format to “XLS” (MS Excel). If any other file
extension is entered as the value, the file type of the log will remain HTML.
4. Restart the portal.

Changes to portal services require restart. If you are planning to make other
changes requiring restart, for example Mapping Page Layouts [Page 39], then
avoid multiple restarts. Just make sure to restart the portal before migration.
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3.2.3. Import Filter for Content Objects
Use
When you import portal content from SAP Enterprise Portal 5.0 to SAP NetWeaver ‘04, the
Import Filter for Content Objects checks the content objects, for example, iViews, pages,
worksets, and roles.
The import filter is shipped as an attachment to SAP Note 642999. For more information, see
SAP Note 642999.

Features
The import filter provides two functions for content objects in SAP Enterprise Portal 5.0 during
the import:
•

Skipping content objects

•

Mapping content objects

The import filter is controlled using the import filter file. The import filter file contains a list of all
content objects that should be skipped and that can be mapped. The system automatically
skips and maps content objects.

You must not make any manual changes to the import filter file. SAP does not
accept liability for or support customer changes to the import filter file.
Exception: This file may be edited only in the event that you have been using
customized page layouts in EP 5.0 and need to map them to new NW ’04
layouts, and only as described in Mapping Page Layouts [Page 39].
Skipping Content Objects
Certain content objects from SAP Enterprise Portal 5.0 cannot or should not appear in SAP
NetWeaver ‘04. The import filter file for the Import Filter lists the content objects that are
skipped during import to SAP Enterprise Portal SP2.
The following objects can be affected:
•

.ivu

•

.par

•

.pag

•

.pcd

Mapping Content Objects
To map content objects, you must use the Import Filter to map paths in SAP Enterprise Portal
5.0 to paths in SAP NetWeaver ‘04. You can only map content objects that are listed in the
Portal Content Directory.
You can only map paths from SAP Enterprise Portal 5.0 (technical names) to the paths in
SAP NetWeaver ‘04 (technical names).

Path mapping:
pcd#/global/services/installed/SAPApplications.BSP=portal_content/com.sap.po
rtal.migrated/ep_5.0/templates/com.sap.portal.appintegrator.sap.bwc.BSP
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If you have been using custom page layouts in EP 5.0, which you want to keep
in the NW ’04 portal, follow the instructions in Mapping Page Layouts [Page 39]
Regular Updates to the Import Filter

SAP regularly changes the import filter file for the import filter. Therefore, before
you import a 5.0 business package, you must check each time that you have the
latest version of the import filter.

3.2.4. Mapping Page Layouts
In EP 5.0 it was possible to create custom page layouts in ASP files. Since these files are not
migrated, neither are the layouts. However, it is possible to recreate these layouts in NW ’04
and, using the import filter file [Page 38], map the EP 5.0 layout files to the new during the
migration process.
Creating Customized Page Layout Templates in NW '04
Create new layout templates according to the instructions and information supplied in the
Help Portal at help.sap.com → Documentation → SAP NetWeaver → People Integration →
Portal → Administration Guide → Content Administration → Portal Pages → Creating a
Customized Page Layout Template.
Integrating New Page Layout Templates in NW '04
Perform the following for each layout template you have created and to which you wish to
map an EP 5.0 layout.

Although there are restrictions imposed by SAP to making changes in the folder
Content Provided by SAP, changes required to map page layouts may be made,
but only if performed precisely as described in this document.
1. Navigate as follows: Content Administration → Portal Content → Content Provided by
SAP → Templates → Layout Templates.
In Quick Info you can see that the ID of this folder is
portal_content/com.sap.pct/templates/layouts.

Do not perform the following steps from any other folder than Layout Templates,
to which you navigated in Step 1. Mapping will not work if the layout templates
are add to a different folder.
2. Right-click the Layout Templates folder and from the context menu choose New From
PAR → Layout.
3. In Step 1 of the wizard, select the desired layout and choose Next.
4. In Step 2 of the wizard, choose a portal component.
5. In Step 3 of the wizard, enter the required values. Choose Next and Finish to the end of
the wizard.
The new layout is added to the Layout Templates folder.
Mapping the EP 5.0 Layouts to NW '04
It is now possible to edit the Import Filter for Content Objects file (cms_mapping.properties) to
map the EP 5.0 ASP files to the new NW ’04 layouts. See section 1d of the import filter file for
an explanation about layout mapping.
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Layout IDs:
In order to map the layouts, you must have the IDs of the EP 5.0 and the NW ’04 layouts.
•

Section 1d in the filter file provide the ID for default layouts. To find further layout ID
information, you can go to the EP 5.0 database and run the query Select * from
p865_colsets.

•

For NW ’04 IDs, go to the Layout Templates folder, as described in the above section
on integrating new layouts into NW ’04.
Select the new layout and note the ID in Quick Info. (The ID is located after the last
backslash (\), in the format <prefix>.<ID>. This ID will be needed for mapping in the
filter file.)

Any change to the Import Filter for Content Objects file
(cms_mapping.properties) requires that the target NW ‘04 portal be restarted.
This must be done before migrating for the mapping to take effect.

3.2.5. Pre-Migration User Management Steps
Procedure
The steps listed below must be taken to enable smooth migration of user management
information from EP 5.0 to NW ‘04. The specific order is not important.
•

Verify that there is read-access to the EP 5.0 corporate and portal LDAP

•

On the NW ‘04 machine, specify the corporate LDAP server and hierarchy type exactly
as they were defined for EP 5.0. Changes in user management configuration cannot be
migrated.
The path in NW ‘04 is System Admin → System Configuration → UM configuration, and
go to:

•

{

Data Sources tab

{

LDAP Server tab

To avoid possible problems accessing the corporate LDAP on NW ‘04, set the
minimum lengths of the user ID and password to ‘4’ on the NW ‘04 machine.
The path in NW ‘04 is System Admin → System Configuration → UM configuration →
Security Settings tab.

•

Resolve any inconsistencies which may exist in EP 5.0 between roles existing in the
PCD and roles in the usermanagement service. Obtain this information by navigating in
EP 5.0 to the following iView: Support → Support Desk → Portal Content Directory →
CompareRoleLists.

•

In case there are inconsistencies, clean up the system by removing roles from
usermanagement that no longer exist in the PCD, or use the option in the
CompareRoleLists page to register the roles in usermanagement.

•

Make sure that in your EP 5.0 LDAP, you design users, groups and roles with unique
names. For example, if you have a user named „User 1“ and an organizational unit also
called „user 1“, and both of them have user mapping, during migration, their mapping
will clash.
Read SAP note 692418 and follow it to ensure smooth migration.
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Backing Up User Management Information
Export your LDAP data and the EP 5.0 database (typically TTPSys) from the LDAP and the
database management system applications used by EP 5.0 (according to the instructions in
the documentation of those applications).
This is recommended for back-up purposes only. During migration, the NW ‘04 portal
connects directly to the EP 5.0 LDAP and database.

It is recommended to back up these files, LDAP data, and database, referred to
above, and the user management files specified in Copying EP 5.0 Files [Page
44] before performing the migration.
Before exporting LDAP and database information, make sure that no users or
administrators are working in EP 5.0.

3.2.6. Verifying Upload of EP 5.0 System Landscape
Use
Two files in EP 5.0 constitute the system landscape of the source portal: systems.xml and
jcoDestinations.xml. To enable the successful migration of the system landscape to the NW
’04 portal, the system landscape files in EP 5.0 must be uploaded. Verify their upload status
according to the following procedure.

This procedure must be performed before you copy files to the NW ’04 portal,
as described in Copying EP 5.0 Files [Page 44].

Procedure
...

1. In EP 5.0, go to System Configuration → System Landscape. and see the Landscape
Upload Status frame in the System Landscape Cockpit.
2. If the files are not uploaded, go to the Landscape Up- and Download Frame and
choose Upload to Portal.
3. In the work area, enter the desired files and choose Upload.

3.2.7. Defining and Verifying Permissions
Use
This section describes pre-migration steps necessary in the NW ‘04 (target) portal for
enabling users to access assigned content and to allow personalization.

Procedure
...

1. Go to System Administration → Permissions → Portal Permissions.
2. Right-click on the root Portal Content folder (pcd:portal_content) and choose
Open Permissions.
For the group Everyone, assign the following permissions:
{

Under Administrator - None

{

Under End User – On (checkbox selected)

{

Role Assigner – Do not change

3. For each subfolder of Portal Content, except for Migrated Content
(pcd:portal_content/com.sap.portal.migrated) and for Portal Users
(pcd:portal_content/every_user), remove the Everyone row.
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4. Navigate to the Layout Templates folder
(pcd:portal_content/com.sap.pct/templates/layouts), under Content
Provided by SAP → Templates.
For the group Everyone, assign the following permissions:
{

Under Administrator - None

{

Under End User – On (checkbox selected)

{

Role Assigner – Do not change

5. Browse to the folder Migrated Content → EP 5.0
(pcd:portal_content/com.sap.portal.migrated/ep_5.0), and add to each
subfolder:
For the content_admin_role role, assign the following permissions:
{

Under Administrator - Full Control

{

Under End User – Off (checkbox cleared)

{

Role Assigner – Do not change

For the system_admin_role role, assign the following permissions:
{

Under Administrator - Read/Write

{

Under End User – Off (checkbox cleared)

{

Role Assigner – Do not change

6. Browse to the Security Zones → com.sap.portal.ep50 folder
(ara:/security/com.sap.portal.ep50),
For the group Everyone, assign the following permissions:
{

Under Administrator - None

{

Under End User – On (checkbox selected)

{

Role Assigner – Do not change

3.2.8. Defining and Configuring a System for EP 5.0
Use
This section details what needs to be done to create an NW ‘04 system pointing to the 5.0
portal. This will enable the NW ‘04 migration utility to access the EP 5.0 databases in order to
process the non-Java content for migration.

Procedure
...

1. From the top-level navigation, go to System Administration → System Configuration →
System Landscape.
2. Navigate to Portal Content and create a new system based on an EP 5.0 system
template.
To create a system, right-click on the desired location (either the root Portal Content
folder or anywhere in the hierarchy), and from the context menu, choose New →
System,.
For details, see the portal administration guide on the help portal, System
Administration → System Landscape → System.
3. Open the new system for editing from the context menu by right-clicking the system
and, choosing Open → Object to open the system Property Editor. (Double-clicking the
system opens the Property Editor by default.)
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4. In the Property Editor, choose EP 5.0 Connection Parameters from the Property
Category drop-down list, and define the following parameters:
{

EP 5.0 Server Name

{

EP 5.0 Server Port

{

EP 5.0 Protocol (valid values: http/https)

{

Location of EP 5.0 Styles – Leave blank

{

Location of System Landscape – Leave blank (for future use)

{

Location of ZAR files - The same location on the NW ‘04 machine to which you
copied them. (This parameter is necessary only if content with services were
created in EP 5.0.)
e.g. …/usr/sap/FP8/JC00/j2ee/migration_ep50/zar

{

Location of User Management – The same location on the NW ‘04 machine to
which you copied the user management and configuration file, e.g.
…/usr/sap/FP8/JC00/j2ee/migration_ep50/ume
See Copying EP 5.0 Files [Page 44].

5. In the Property Editor, choose EP 5.0 Database Connection Parameters from the
Property Category drop-down list, and define the following parameters to the portal
repository database:
{

Connection URL
Use a URL that matches the drive ClassName. For example:



For com.sap.portals.jdbc.sqlserver.SQLServerDriver, use
jdbc:sap:sqlserver://<host>:1433;DatabaseName=<database_name(typic
ally TTPSys)>



For com.sap.portals.jdbc.oracle.OracleDriver, use
jdbc:sap:oracle://<host>:1521;sid=<schema_name>



For driver oracle.jdbc.driver.OracleDriver use jdbc:oracle:thin:@<host
name>:<port>:<SID>

{

Database Administration Password

{

Database Administration User ID
The default database user with SQL Server is EPUser.
The default database user with Oracle is TTPSYS.

{

Driver Class Name
Select the driver class name from the drop-down list of installed drivers. An
example of a driver class name is:



com.sap.portals.jdbc.oracle.OracleDriver

6. A specific default system alias must be defined on the NW ’04 machine for the EP 5.0
system which was created there. Add the alias DEFAULT_EP5_SYSTEM to the EP 5.0
system opposite which NW ’04 is working. If this is not the first alias given to the
system, select it as the default alias.
To the system aliases, choose System Aliases in the Display selection list at the top
right of the system Property Editor.
For more information, see the section on system aliases in the portal administration
guide at help.sap.com/NW ‘04 → <language> → SAP Library → SAP NetWeaver →
People Integration → Portal → Administration Guide → System Administration →
System Configuration → System Landscape → System Aliases.
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3.2.9. Checking the EP 5.0 Language Table
Use
Before running the migration from EP 5.0 to NW ‘04, make sure that the supported languages
table in the EP 5.0 database is configured correctly. Although missing entries in the
Supported Languages table do not affect portal functionality, they may cause a partial failure
of the migration process.

Procedure
Run the following query on your EP 5.0 database (typically TTPSYS):
select * from P310_SUPPORTED_LANGUAGES
The result of the query should be several lines in the following format:
LANGUAGE_ID

LANGUAGE_NAME

-1

LANGUAGE_SYMBOL
NULL

0

Neutral

neutral

7

Deutsch

de

9

English

en

10

Espanol

Es

12

Francais

Fr

16

Italiano

It

22

Portugues

pt

Although it is recommended that all of the above entries appear in the table, it is not
mandatory. Only the entry for LANGUAGE_ID 0 (Neutral) is mandatory. If it is missing from
the database it needs to be entered manually.

3.2.10. Copying EP 5.0 Files
Use
This section describes in detail the EP 5.0 files related to user management, Portal Content
Directory (PCD), and system landscape, which need to be copied to the NW ‘04 machine so
that they are available for processing and import by the NW ‘04 migration utility.

Procedure
Copy the files listed in the table from the specified source location on the EP 5.0 machine to
the specified destination directory on the NW ‘04 machine.

Compressing the files to be copied significantly reduces the transfer time (as
much as 20%). Any compression utility may be used. If your preferred utility is
not capable of compressing the number of files you have, it is possible to create
more than one .zip file. It is important, however to build the content of the
directory as it was on the source portal machine.
SAPCAR is the SAP proprietary, platform independent compression utility which
is available from your NW ‘04 installation. SAPInst automatically unloads
SAPCAR into the following directories:
For Windows in ...\Program Files\sapinst_instdir
for Unix, – in the directory from which SAPInst is launched
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EP 5.0 Files to Copy
Action

From (on EP 5.0 machine)

To (on NW 04 machine)

User management:
Copy all files and subfolders.

<irjRootFolder>\WEBINF\plugins\portal\services\us
ermanagement\data

/usr/sap/sap_system_id/<J2E
E_instance>/j2ee/migration_e
p50/ume

Where the <irjRootFolder> is
typically:

You need to create this
directory.

SAP_J2EEngine6.20\<alone
or
cluster>\services\servlet_jsp\
work\jspTemp\irj\root
PCD:
Copy all files and subfolders.

Open the pcd.properties file:
<irjRootFolder> \WEBINF\plugins\portal\system\
properties\pcd.properties
Find the value of the property
pcd.home
The default is: C:\Enterprise
Portal\DataFile\data
The pcd.home property
represents the folder from
which you need to copy all
files and subfolders. (Do not
copy the folder itself.)

The directory dedicated to
PCD migration
Find the path to this directory
as follows:
In top-level navigation,
System Administration →
Support
From the portal Support Desk
page, select Portal Content
Directory.
Under Test and Configuration
Tools, select PCD
Configuration.
The path to the directory is
listed under Parameters for
Portal Content Migration, in
the field
Pcd.Migration.TempPcdRoot
Directory
Typical path:
/usr/sap/sap_system_id/<J2E
E_instance>/j2ee/temp/pcd/M
igration/Pcd
If this path does not exist in
the file system, create it
manually.
If the path exists, its content
may be moved to another
location if desired. The
content in this directory would
already be written to the
database; it exists here for
backup purposes.
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ZAR:
Copy only those ZAR files
created by your organization.
Do not search for and copy all
such files.
On the target system, remove
the .bak extension.

Search for proprietary ZAR
files (that is, only those ZAR
files that were created within
your organization for your
portal), starting from your irj
root folder. Copy these files to
the specified location on the
target machine.
If you were working with
business packages, there
may also be ZAR files
associated with them. These
should also be copied to the
target machine.
For example, if you are
working with CRM in EP 5.0,
do the following:

/usr/sap/
sap_system_id/<J2EE_instan
ce>/j2ee/migration_ep50/zar
You need to create this
directory.

After copying into specified
folder on the target system,
remove the .bak extension
from all the ZAR file names.
For example, rename the file
crmcontext.zar.bak to
crmcontext.zar.
For more details, see SAP
Note 761545.

On you EP 5.0 machine,
search for
crmcontext.zar.bak (it
should be located in
<irj_root_folder>\root\WEBINF\deployment). Then move
it to the target machine.

Note that the path examples in the table are typical Unix format. On PC, the
path is preceded with the drive, for example, C:\, and it would contain back
slashes instead of forward slashes.

3.2.11. Running the EP 5.0 Support Platform Plug-Ins
The Support Platform is an SAP-proprietary testing engine for running checks and fixes on
portal systems. Running the EP5 to NW04 Migration set of pre-migration plug-ins is an
important aid to prevent needless migration failure, causing additional downtime.

Verify that Support Platform is Started
Before trying to run the plug-ins, make sure that the Support Platform application is running.
This can be done with a few telnet commands:
1. Access telnet with:
<machine_name> <portal_port_+_8 (e.g. 50008)>
2. Log in to telnet with the Administrator user (user from the group Administrators).
3. Enter password.
4. Jump to any server node:
jump 0 (goes to the first server node)
or:
jump <server_id>
5. To add the required group of commands, enter the command:
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add deploy
6. Now enter:
list_app | grep supportplatform
This returns:
sap.com/com.sapportals.supportplatform
(e.g. 0 0_65012)>

STARTED/STOPPED

Server <server_id

7. If the Support Platform is stopped, run the command:
start_app sap.com/com.sapportals.supportplatform
Alternatively:
You can start the application from the J2EE Visual Admin tool, as follows:
1. Log on to the J2EE Visual Admin tool and go Server → Services → Deploy.
2. In the Deployed Components pane, go to Deploy Service → Server → servlet_jsp →
sap.com/con.sapportals.supportplatform.
3. Choose Start Application and in the window that opens, which shows all the server
nodes checked, choose OK.

Accessing the Support Platform
There are two ways of accessing the Support Platform:
1. Type your target portal URL in a browser address field with the alias “sp” instead of “irj”
(<hostname>:<port>/sp).
Log on with your regular portal username and password.
2. Alternatively, from within the target portal, navigate as follows: System Administration
→ Support (opens the Support Desk page) → Support Platform (opens the Support
Platform general info page), and select the link Click here to open the Support Platform.

Running the Plug-Ins
1. In the Support Platform Plug-ins navigation panel, expand the folders Enterprise Portal
→ EP5 to NW04 Migration → Pre-Migration. The following plug-ins are exposed:
Check Migration System

Checks that there exists, on the target portal, an EP 5.0
system with the alias DEFAULT_EP5_SYSTEM.

Check DB Connection

Checks database connectivity:
•

Takes system parameters and tries to connect to the
EP 5.0 database.

•

Verifies that default language is configured.

Check Permisison Settings

Checks that correct permissions exist.

Check System Landscape

Checks if systems.xml and jcodestinations.xml exist in the
correct location.

2. Select the Pre-Migration folder and then Run. Selecting the folder runs all the plug-ins
in the correct order. This is important since there are sequential dependencies between
the plug-ins. In a cluster environment, you can choose Run on all nodes.
The results are displayed in the Support Platform result panes on the right.
Support Platform documentation:
For detailed information about the Support Platform and how to use it, see The NetWeaver
Support Platform, located at help.sap.com/nw4 → Documentation SAP Solution Manager →
English → SAP Library → SAP NetWeaver → Solution Life Cycle Management → Support
Platform.
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3.3. Migrating the Portal
Use
Running the migration utility processes and imports your EP 5.0 content, preserving it for use
after moving to NetWeaver ‘04 as your company portal.

Prerequisites
You have performed all the required actions to prepare for the migration, as specified in the
Process Flow section of Enterprise Portal Migration [Page 33].

The user who implements the migration process must be assigned to the Super
Administrator role.

If you are working with KM and have not yet imported the KM backward
compatibility package, do this before you start portal migration. For details, see
Importing the Compatibility Package [Page 31].

Procedure

To be sure of data integrity, it is recommended to shut down the source EP 5.0
SP6 portal before starting the migration.
...

1. From the top-level navigation of the target NW ’04 portal, go to System Administration
→ System Configuration → System Landscape.
2. Right-click the EP 5.0 system you created for EP 5.0, and choose Migrate from the
context menu.
The migration page appears, displaying a list of portal components to be migrated,
according to component type. It also displays a link to a log of the whole migration
process and shows a status column containing links for indicating the current migration
status of each component.
3. When the migration page appears, choose the Migrate button.
A popup window appears showing a progress bar that indicates the general progress of
the entire migration.

The status links for the individual portal components are updated every few
seconds in synchronization with the general progress indicator.

Choosing the Cancel button on the migration progress window stops the
migration process without erasing created content. This is not recommended
unless, for some reason, the migration process hangs.
4. When the migration progress indicator shows 100%, choose Done to close the popup
window.
5. After migration is finished, restart the SAP J2EE Engine.
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Result
At this point the automatic migration process is complete. The migrated EP 5.0 content
appears in your portal under Portal Content in the folder Migrated Content, which is created
when the portal is installed.

This does not apply to content components of an administrative type, such as
user management, which would be written to the portal database.

Migration Status
The status of the migration is shown, per component, by the hypertext link in the status
column of the migration page. The links point to log files from which information can be
obtained about the migration process of each and every component. Use this information for
fixing problems that may have impeded the successful migration of specific components.
These logs remain, unless overwritten by a subsequent migration.
For more information about the logs and troubleshooting, see Troubleshooting the Portal
Migration [Page 59].
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4. Post-Migration Activities
For the migration process to be complete for both KM and the portal, certain post-migration
activities must be performed after the successful implementation of the respective automatic
migration tools.

4.1. Post-Migration Activities for KM
Purpose
To complete the migration, you configure repositories and migrate customer components with
the help of the information generated by the migration reports. You also delete obsolete
system IDs in the cluster and determine if it is necessary to reassign users to NW ‘04 roles.

4.1.1. Performing Tasks Identified by Reports
Use
Use the information generated by the Customer Components and Repository Managers
reports to perform additional manual migration steps.

If you do not perform the additional manual migration steps, your system may
not start up.

Procedure
...

1. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and
open the report for the Customer Components. Alternatively, you can access the
reports directly in the folder which you specified for the results.
The Customer Components Report identifies components that were developed after
the original KMC installation and which you must therefore migrate manually. It shows
a list of xml configuration files that exist on the target system without corresponding
java classes. You have to deploy the Java classes corresponding to the XML files
manually because they are not transferred during the normal migration procedure.
KMC displays errors on the target system if it registers that xml files point to java
classes that do not exist in the system. The errors no longer occur after the deployment
of the corresponding Java classes.

If you used the Config option of the migration tool to exclude XML configuration
files of custom developments from the migration, then these errors are not
displayed.
2. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and
open the report for the Repository Managers. Alternatively, you can access the report
directly in the folder which you specified for the results.
With the help of the report, identify problems related to the configuration of repositories
on the target system and resolve them with the instructions provided. Due to the move
from one machine to another, the configuration of some repositories is no longer valid.
For example, if you have configured a local repository on the source system, then the
path to the repository will no longer be correct on the target system. The report informs
you of the tasks that are necessary to configure the repositories correctly.
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4.1.2. Deleting System IDs
Use
After the migration, the system IDs of the old EP 5.0 system and the new NW ’04 system are
active in the configuration. You therefore need to delete the obsolete EP 5.0 system IDs.
Cluster only:
After deleting the old system IDs, you make sure that scheduled tasks are assigned to the ew
IDs.

If both the old and the new system IDs are active, an error appears in the
component monitor. To check for the error in the portal, choose System
Administration → Monitoring → Knowledge Management → Component Monitor
KMC → Component Monitor → Services → Landscape Service:
Configuration Error: Cluster mode not enabled

Procedure
...

1. Log on to the portal and choose System Administration → System Configuration → KM
→ Content Management.
2. Choose Global Services → System Landscape Definitions → Systems → Content
Management Systems.
The system ID is displayed.
3. Delete the EP 5.0 system ID. You made a note of it in preparation for the migration.
Cluster only:
In a cluster configuration with several instances:
a. Delete all the system IDs that originate from the source system. You made a
note of these in preparation for the migration.
b. Assign scheduled tasks to the new system IDs.

You must explicitly assign tasks to a system ID, otherwise they are not
executed.
To assign tasks:
i.

Return to Global Services and choose Scheduler Tasks.
A list of scheduler tasks is displayed.

ii.

Make sure that the tasks listed are all assigned to the new NW ‘04
system IDs. Change any assignment that still uses old system IDs.
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4.1.3. Initializing Ad Hoc Workflow Templates and Object
Types
Use
To enable the use of templates and object types in Ad Hoc Workflow, you need to manually
initialize them.

Procedure
...

1. Access the workflow templates in the portal with Content Administration → Workflow
Content → Workflow Templates.
2. Choose Restore Default Templates.
The default workflow templates are automatically initialized.
3. To access the object types for tasks, enter the following address:
http://<servername>:<portNumber>/irj/servlet/prt/portal/
prtroot/com.sap.workflow.apps.BusinessObject
4. Choose Browse and then navigate to the folder:
\usr\sap\<SAPSID>\JC<number>\j2ee\cluster\server0\apps\sap.com\
irj\servlet_jsp\irj\root\WEBINF\portal\portalapps\com.sap.workflow.apps\privat\install\objTy
pes
5. Select WFTask.xml and choose Upload.
The object types for workflow tasks are created.

4.1.4. Assigning Users to New NW '04 Roles
The roles in EP 5.0 SP6 and NW ‘04 are different. The EP 5.0 role km_admin no longer exists
in NW ‘04. Also the System Principal that could be assigned directly to users and allowed full
access to all content no longer exists. Users who are System Principals in EP 5.0 are not
System Principals in NW ‘04 and are therefore restricted in accessing content. It is therefore
necessary to reconsider the assignment of users to roles in the NW ‘04 target system.
The default administration roles that are available in NW ‘04 are:
•

system_admin_role

•

super_admin_role

•

content_admin_role

•

user_admin_role

For information on the default assignment of Knowledge Management content to roles in NW
‘04, see help.sap.com → SAP NetWeaver → Information Integration → Knowledge
Management → Administration Guide → Content Administration → Roles.
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4.2. Post-Migration Activities for the Portal
Purpose
For the portal migration process to be complete, with EP 5.0 content operating satisfactorily in
NetWeaver ’04, post-migration steps must be performed for the following components:
•

User management

•

Removing and Verifying Permissions

•

User Mapping with Data Sources

•

Styles and themes

•

J2EE Engine and content customized with code

•

Proxy server

•

Working with back-end systems

•

Support for EP 5.0 .NET iView

•

External Services

•

Migration of Favorites

After performing post-migration activities, restart the J2EE server.

4.2.1. User Management
•

The migration process does not include migrating the portal_user or the portal_admin
roles. The respective, parallel roles in NW ‘04 are eu_role and super_admin_role.
{

After migration, assign eu_role to the Everyone group. Refer to SAP Note
685227 for details.

{

If either of these EP 5.0 roles, portal_user or the portal_admin, had essential
content associated with them, this content must be reassigned in EP 6.0.

The EP 5.0 admin user is not migrated to the NW ’04 system. In EP 5.0, there was only
one admin role, defined as the super admin, and in NW ’04, administration is
delegated; therefore, you need to reassign admin permissions in NW ‘04.
•

For Single Sign-on to continue functioning after migration, SAP systems need to be
configured to trust the NW ’04 logon ticket just as the ticket was trusted in EP 5.0.

For more information, see “Configuring SAP Systems to Accept and Verify SAP Logon
Tickets” in Security Guide – SAP NetWeaver, located at service.sap.com/instguidesNW ‘04 →
Installation & Upgrade Guides → SAP NetWeaver → Release 04 → Planning.
UME Verification after Migration
It is recommended to check user management engine functionality. After you finish migration,
check role assignments, user mapping, and additional attributes.
•

Search for a user_id or name and verify that the user properties, such as language and
roles, are correct.

•

Log on as an end user and verify that roles and personalization have been migrated.
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4.2.2. Removing and Verifying Permissions
...

1. Go to System Administration → Permissions → Portal Permissions.
2. Navigate to the Layout Templates folder
(pcd:portal_content/com.sap.pct/templates/layouts), under Content Provided by SAP →
Templates and remove the Everyone row.
3. Browse to the folder Migrated Content → EP 5.0
(pcd:portal_content/com.sap.portal.migrated/ep_5.0), and remove the Everyone row for
the following subfolders:
{

Roles

{

Services

{

Templates

{

Worksets

4.2.3. Styles and Themes
Use
The migration of styles and themes from EP 5.0 to the NW ’04 portal is a manual, not an
automated procedure. Themes and styles from EP 5.0 must be downloaded in EP 5.0 and
then manually uploaded to the NW ’04 portal, where they need to be processed before they
can be properly viewed.

Procedure
...

1. In EP 5.0, navigate to System Configuration → Styles → Related Tools → Style
Archive.
2. From the download area, save the .zip file of the desired style.
Now the style can be uploaded to NW ’04 by browsing to the saved location from the
NW ’04 theme archive.
The navigation path to the NW ‘04 theme archive is System Administration → Portal
Display → Theme Archive.
3. For detailed information about post-migration processing of theme elements, refer to
SAP Note 658798. (Although this note was written originally for EP 6.0 SP2, its
contents remain valid for NW ’04.)

Additionally, EP 5.0 style personalizations have been removed during migration.
After uploading and processing the themes in NW ’04, the themes, together with
framework pages, can be assigned to desktop objects by an administrator, using
the Portal Desktop Editor during design time.
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4.2.4. J2EE Engine and Content with Code
...

1. If you created customized content using code, make the required adaptations to the file
names and their contents, if necessary, to support case sensitivity for Unix.
2. If a connection pool was created in EP 5.0 for custom applications, make sure to
recreate it for NW ’04, as it was defined in J2EE for EP 5.0.
3. If EJBs were created and deployed in EP 5.0, redeploy them in J2EE 6.40 for NW ‘04.
If you have customized content using code, or you are running applications specific to
SAP J2EE Engine 6.20, you may be able to convert these to work with SAP J2EE
Engine 6.40 using the SAP J2EE Engine Converter and Deploy tools.
For details, see the section on incompatibilities between J2EE 6.20 and 6.40 in the
migration manual for SAP J2EE 6.20 to 6.40 at help.sap.com/nw4 → English → SAP
Library → SAP NetWeaver → Application Platform (SAP Web Application Server) →
Java Technology in SAP Web Application Server → Migration.
4. If additional JARs were copied to EP 5.0, they need to be recopied to NW ’04.
See the section on incompatibilities between J2EE 6.20 and 6.40 in the migration
manual for SAP J2EE 6.20 to 6.40, if necessary.
5. If you have custom tuning and configuration changes, which were made in J2EE
Engine in 6.20, and need to find the corresponding settings and system properties in
J2EE 6.40, this information is also covered in the section on incompatibilities between
J2EE 6.20 and 6.40 in the migration manual for SAP J2EE 6.20 to 6.40.
6. If the files library.txt or reference.txt were changed in EP 5.0, the changes must be
redone for NW ‘04.
7. If additional HTML files were created in EP 5.0, copy them to the docs folder on the NW
’04 machine, \j2ee\j2ee_<instance_no>\docs.

4.2.5. Reconfiguring the Proxy Server
If your EP 5.0 portal was working with a proxy server, the proxy settings were not copied to
the NW ’04 portal during migration. You need to reconfigure these settings. To do so, go to
System Administration → System Configuration → Service Configuration → Applications →
com.sap.portal.ivs.httpservice → Services → proxy. For documentation, go to
help.sap.com/NW ‘04 → English and navigate to the System → System Configuration →
Service Configuration → System Properties for Proxy Server section of the portal
administration guide.

4.2.6. Working with Back-End Systems
If you are using systems in the source portal system landscape, which are based on SAP
backend systems, such as R/3, BW, and CRM, and which are authenticated using
SAPLOGONTICKET, you need to recreate the trust between the NW ‘04 portal and the
relevant SAP backend system.

4.2.7. Support EP 5.0 .NET iViews
A specific default system alias must be defined on the NW ’04 machine for the EP 5.0 system
which was created there. If you have not already done so before migration, when you created
and configured your EP 5.0 system on the NW ’04 machine, add the alias
DEFAULT_EP5_SYSTEM to the EP 5.0 system and make sure to select it as the default
alias, if it is not the only one.
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4.2.8. External Services Based on Standard.PAR
Use
After migration, the Options menu will not be available for External Services that are based on
Standard.PAR, unless the following procedure is performed.

Procedure
1. Go to Content Administration → Portal Content, and navigate to Migrated Content →
EP 5.0 → Templates → Standard.URLComponent, and open the object Property
Editor.
2. Change the Property Category to Load.
3. Change the Isolation Method property value to URL.

4.2.9. Migration of EP 5.0 Favorites
Use
The Enterprise Portal 5.0 user could save useful pages, resulting from portal navigation, as
favorites in the browser by clicking the Add to Favorites link. After migration to NetWeaver
’04, the targets of the saved URLs are no longer at the same location. The following
instructions explain the tasks required to enable access to EP 5.0 portal favorites.

Prerequisites
Requests for favorites must be redirected to the correct server. This should be performed by a
domain administrator. Use an existing proxy server or a separate Web server for redirection.
If you use a separate Web server, the only requirement is that it be capable of redirecting a
request to a specific port.

If you don’t want to keep an additional Web server alive, just for the purpose of
redirection, have users create new favorites after redirection.
An EAR file has been downloaded from SAP Note 834466.

Procedure
The EAR file, which constitutes an application for translating the favorite URL to the
corresponding server and port, must be configured and deployed using the J2EE server
admin tool.
Configuring and Deploying EAR File
...

1. Open the J2EE server admin tool.
2. Expand the relevant server node: <server> → services → deploy.
3. Under the work area, choose the Application radio button.
4. Choose the Deploy & Start to open the dialog in which you enter the EAR file.
5. Browse to the EAR file and choose OK, then OK again in the Deploy dialog, and OK
again.
The EAR file (sap.com/EP5.0 Favorites Migration) is added to the list of
application that work on top of the J2EE server.
6. In the admin tool navigation panel on the left, choose Web Container to view a list of all
applications that work on top of the J2EE server.
7. Drill down and select the top-level node of SAPPortal.
8. Click the View button on the right and choose the Context Parameters tab.
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9. In the navigation panel, select the portalAddress parameter, and in the Parameter
Value field on the right, change the value to the NW ’04 address. The correct format
appears by default:
<protocol>//<NW_portal_server>:<NW_portal_port>
This value from now on serves as the NW ’04 address.
10. Choose Modify and then Save. A confirmation notice is returned.
Clicking OK on the confirmation notice restarts the application.

Result
Users may still take advantage of useful information returned by favorites saved to their
browsers while working with EP 5.0.
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5. Troubleshooting the EP 5.0 to NW '04
Migration
In the event of problems incurred during the migration process for KM or the portal, check the
status of the process as described in the following sections.

5.1. Checking the Status of the KM Migration
Use
Log on to the target system and check the component monitor to assess the status of the
migration.

Procedure
...

1. In the portal, choose System Administration → Monitoring → Knowledge Management
→ Component Monitor.
2. In the component monitor, click Filters, Repository Managers, Repository Services and
Services. For each of these items, check the subentries. Keep in mind that if you have
not yet performed the necessary actions identified by the Repository Managers Report,
tool during the repository check, the repositories will indicate errors:
The colors beside the entries indicate the following:
{

Green shows the object is functioning well.

{

Red shows the object cannot be started or is configured incorrectly.

{

Yellow indicates that one or more lower-level items are red.

3. If Content Management does not start up, there might be a problem with the database
connection. To find out more, check the available log files:

For UNIX, replace the backlashes in the paths with slashes.
...
...

a. Switch to the directory:
<Drive>:\usr\sap\<SAPSID>\JC<J2EE_instance_number>\j2ee\
cluster\server0\log\
b. Open the file defaultTrace.0.trc with the most recent date. If errors appear
in the trace file, try to solve them and then restart the SAP J2EE Engine.

You can also view the trace file using the log viewer that is available in the SAP
J2EE Visual Administrator.
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5.2. Checking the Status of the Portal Migration
As the migration utility works on reading content from EP 5.0 and importing it to NW ‘04, it
writes its progress to two separate types of log files.

For detailed troubleshooting information about portal migration, see SAP Note
703034 and its attachment.
Log Types
Type

Access

Description

General migration log

Choosing the Status
hypertext link at the top
of the migration page

Overview of migration process, indicating
status of each component together with
available information, including a report
on the quantity of migrated components.

Component-specific log

Choosing the hypertext
link in the Status column
on the same row as the
specific component

Provides detailed information about the
migration of the component, including
what happened, and why, and an
quantitative report on the number of
items migrated.

The quantitative report may be useful even for successfully migrated
components, as a check to see if all the items migrated were actually copied
correctly to the NW ‘04 machine.
When an error occurs in migration, or when requesting help from development support,
always refer to the log and systems files:
Log files

<irjRootFolder>\portalapps\com.sap.portal.upgrader.upgraderservice\<last
created folder>

System files

systems.xml and jcoDestinations.xml can be found at Enterprise
Portal\DataFile\data\Pcd\system\landscape, where Enterprise Portal is
Pcd.Home

Console log files

<install directory>\cluster\server\log\default_trace
Look at the latest <…>_output.log & <…>_error.log files.

UME log files

/usr/sap/sap_system_id/<J2EE_instance>/j2ee/migration_ep50/ume
See usermanagement_error.log and usermanagement.log.

Log File Color Legend:
Green:

The migration was Successful

Gray:

Comments have been logged

Blue:

Warning is indicated and described

Red

Error is indicated and described

Migration of SAP Enterprise Portal 5.0 to NetWeaver '04

59

5.2.1. Continuing the Portal Migration after Fixes
At the top of the migration page are a Migrate button, a Recover button, and a checkbox
labeled Overwrite Existing Data. There are several courses of action after issues hampering a
successful migration have been fixed. The following table describes the possible actions and
their results.
Actions for Continuing Migration Process
Action

Description

Use

Choose Migrate

The migration process restarts and
progresses without overwriting
content already existing from a
previous migration attempt.

Useful if, for any reason, you
needed to manually delete
content that was already
migrated.

Select Overwrite Existing
Data and Migrate

The migration process restarts and
overwrites existing content.

Useful in the event of corrupt
content, for example, iViews
that, for some reason, the
migration could not
successfully recreate in NW
‘04.

System and datasource objects are
not overwritten. If errors are
returned, consult the
troubleshooting SAP Note 703034.
Choose Recover (Do not
choose to overwrite)

The migration process restarts,
working only on those components
that were not previously migrated.
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6. Migration of Business Packages
The migration of portal content, which was imported in the source system from business
packages, consists of the correct preparation of that content before implementing the
migration process for EP 5.0 to NW ‘04.

Purpose
When you upgrade your portal installation from SAP Enterprise Portal 5.0 to SAP NetWeaver
’04, you can migrate your existing content without losing your personalization settings.
This documentation explains which special points you must follow during the migration of
business packages.

Prerequisites
•

In addition to your SAP Enterprise Portal 5.0, you have installed a SAP NetWeaver
‘04.

•

If you are using a business package based on WebAS 6.20, you must have installed
the SAP Java Connector (JCo) Proxy Runtime, Release 2.0.8 or higher. For more
information about the SAP JCo Proxy Runtime, see SAP Note 595987.
This activity is not required for WebAS 6.40.

•

You have installed the import filter [Page 36].

Process Flow
You must work through the following steps to migrate business packages:
...

1. Prepare for business package migration.
2. Migrate the actual business packages.
3. Complete the post-processing steps for the migration.

6.1. Preparing for Business Package Migration
Before you can migrate business packages, you must complete the preparation steps. You
have worked through some of the following steps to prepare for the migration of the portal or
Knowledge Management. If you have not done this, you must do it before migrating business
packages.
The following preparations must be made:
•

You have imported the compatibility package to SAP NetWeaver ’04.

Business package objects that contain links to content objects in Knowledge
Management (KM) and that are migrated from SAP Enterprise Portal 5.0 to SAP
NetWeaver ’04 cannot find their target objects in KM after the migration because
the naming conventions for KM content objects have changed in SAP
NetWeaver ’04. Therefore, you must use the Compatibility Package for KM to
map the paths again.
The Compatibility Package for KM is shipped as an attachment to SAP Note
640634. You can find the procedure in this guide in the Importing the
Compatibility Package [Page 31] section in the Knowledge Management
Migration section.
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Importing the Compatibility Package is part of the migration process of KM. If
you have KM installed and migrated from the source system, you do not need to
perform the import again. If you do not have KM installed, you still may have
business package content with KM iViews; therefore, you must still import the
Compatibility Package, although you may can do this either before or after the
migration.
•

For the migration, you require a release of the business package that is released for
migration. Usually, this is the latest release of a business package. For information
about the release status of business packages, see SAP Note 642775.
A business package has one of the following statuses:
{

5.0 business packages that are released for SAP NetWeaver ‘04.

{

5.0 business packages that are released for SAP NetWeaver ’04 with additional
languages.

{

5.0 business packages that are not released for SAP NetWeaver ‘04.

If you have not installed this particular release of the business package, you
must upgrade the business package before migrating it.

The Business Package for Projects is available in the releases 50.1, 50.2, and
50.3. Only release 50.3 is released for SAP NetWeaver ’04; you can use only
release 50.3 for the migration.

If you want to use a business package release that contains additional
languages, you must also first import a release of the business package that is
released for migration and work through the migration. After the migration, you
can then import the business package release that contains the additional
languages.
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6.2. Migrating Business Packages
Prerequisites
You must have completed the preparations [Page 61] for migrating business packages.

Effects of the Migration
•

The system landscape connects portal content to the backend systems.
For more information about the system landscape, visit the SAP Help Portal at
help.sap.com → Documentation → SAP NetWeaver → SAP NetWeaver ’04 → People
Integration → Portal → Administration Guide → System Administration → System
Landscape.
The systems.xml and jcodestination.xml files are converted to system objects.

•

In SAP NetWeaver ‘04, the channels from SAP Enterprise Portal 5.0 are converted to
folders and placed in the Portal Content → com.sap.portal.migrated → ep_5.0
directory.

Procedure
Once you have completed the preparations, you can perform the migration as described in
the Migrating the Portal section.
You can find the imported and migrated objects in NetWeaver ‘04 portal in the portal catalog
at Portal Content → Migrated Content → EP 5.0.
For more information about importing content objects, visit the SAP Help Portal at
help.sap.com → Documentation → SAP NetWeaver → SAP NetWeaver ’04 → People
Integration → Portal → Administration Guide → System Administration → Transport of Portal
Objects → Transport Scenarios → Import and Deployment → Importing EP 5.0 Packages.

Result
The 5.0 business packages are available in SAP NetWeaver '04.

6.3. Post-Processing Steps for the Migration
After completing the migration, you must work through the following activities, if they are
relevant for your implementation:
•

If you want to use business packages that contain additional languages, import the
business package release that contains the additional languages to SAP NetWeaver
’04 after completing the migration.

•

If you have implemented the Business Package for Communication, you must make
the modifications that are described in the Modification for the Business Package for
Communication [Page 64] section.

•

If you have implemented the Business Package for Portal Users, you must make the
modifications that are described in the Modification for the Business Package for Portal
Users [Page 64] section.
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6.3.1. Modifications for the Business Package for
Communication
In SAP NetWeaver ’04, the groupware is connected through the portal platform. Therefore,
the Business Package for Communication is no longer offered. Some of the business
packages developed for SAP Enterprise Portal 5.0 that are released for SAP NetWeaver ‘04
contain groupware iViews from the Business Package for Communication. However, these
iViews cannot be migrated.
The following business packages are affected:
•

Business Package for CRM 3.1 60.1

•

Business Package for CRM 4.0 60.1

During the migration, the import filter skips these iViews, as a consequence, they are not
displayed in NetWeaver ’04. For more information, see the documentation on the import filter
[Page 36].
For more information about the necessary modifications, see SAP Note 640678.

6.3.2. Modifications for the Business Package for Portal
Users
In SAP NetWeaver ’04, the Business Package for Portal Users is no longer offered. With SAP
Enterprise Portal 6.0, iViews that were part of the Business Package for Portal Users are
delivered with the portal platform as standard content.
This means that the portal user role in SAP Enterprise Portal 5.0 cannot be migrated to SAP
NetWeaver ’04. Instead, SAP NetWeaver ‘04 contains the standard user role, which replaces
the portal user role in SAP Enterprise Portal 5.0.
If you want to migrate selected content from the Business Package for Portal Users, you have
the following options:
•

To migrate the Universal Worklist, you install the backwards compatibility package.
Once you have done this, you must configure the Universal Worklist again.
For more information read SAP Note 642827.

•

To retain the personalization settings, assign the eu_role role to the Everyone group
after the migration.
For more information, see SAP Note 685227 and the User Management section in the
Post-Migration Activities for the Portal section of this guide.
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